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Cumulus Photo Suite is an Option that supports raw image
formats of a wide array of digital cameras. Comprised of the
Cumulus Digital Camera Raw Filter and the IPTC Information
Window, this is clearly a top-of-the-line software for digital

photographers.

Intro
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Overview

With Photo Suite, you can find and organize raw image formats
efficiently. Photo Suite can extract metadata of raw image formats
and store it in Cumulus catalogs. Additionally, EXIF information
(camera settings, date, aperture and shutter speed etc.), and
depending on the camera model, annotations and GPS are also
captured when cataloging. Even Canon thumbnail files (THM) are
supported. Converting assets stored in raw image format to JPEG
and TIFF images on-the-fly with Cumulus is a breeze. Yet another
benefit presented by Photo Suite is the IPTC Information Window.
Users can easily view and edit metadata. Cumulus Photo Suite
includes the following components:

- Digital Camera Raw Filter

+ Canon Raw Metadata Support

+ |PTC Information window

Digital Camera Raw Filter

The Digital Camera Raw Filter enables Cumulus to capture infor-
mation when cataloging raw image formats and to preview raw
image formats. The captured information will be stored in Cumu-
lus record fields.

The Digital Camera Raw Filter can capture metadata from the dif-
ferent raw image formats defined by leading camera manufactur-
ers, namely, Canon, Fuji, Kodak, Minolta, Nikon, Olympus, Sigma,
Sinar and Sony. The Digital Camera Raw Filter supports images of
the following asset formats:

+ Canon DC Raw Image (extension: crw, Mac File Type: CCDR)

+ Fuji DC Raw Image (extension: raf, Mac File Type: RAF *)

+ Kodak DC Raw Image (extension: dcr, Mac File Type: KDCR)

+ Minolta DC Raw Image (extension: mrw, Mac File Type: MRW *)
+ Nikon DC Raw Image (extension: nef, Mac File Type: NEF *)

+ Olympus DC Raw Image (extension: orf, Mac File Type: ORF *)
+ Sigma DC Raw Image (extension: x3f, Mac File Type: FOVb)

- Sinar DC Raw Image (extension: sti, Mac File Type: TIFF)

+ Sony DC Raw Image (extension: srf, Mac File Type: SRF *)

* Mac File Types with 3 characters only end with a space



Supported cameras are:

Canon PowerShot 600

Canon PowerShot Prof

Canon PowerShot A5

Canon EOS D30

Canon PowerShot A50

Canon EOS D60

Canon PowerShot Pro70

Canon EOS 10D

Canon PowerShot G1

Canon EOS 300D

Canon PowerShot G2

Canon EOS DIGITAL REBEL

Canon PowerShot G3

Canon EOS Kiss Digital

Canon PowerShot G5

Canon EOQS D2000C

Canon PowerShot S30

Canon EOS-1D

Canon PowerShot S40

Canon EOS-1DS

Canon PowerShot 545

Canon EOS-1D Mark Il

Canon PowerShot S50

Fuji FinePix S2Pro

Fuji FinePix S5000

Fuji FinePix S7000

Fuji FinePix F700

Minolta DIMAGE 5

Minolta DIMAGE 7

Minolta DIMAGE 7i

Minolta DIMAGE A1

Minolta DIMAGE A2

Kodak DCS315C Kodak DCS330C
Kodak DCS420 Kodak DCS460
Kodak DCS460A Kodak DCS520C
Kodak DCS560C Kodak DCS620C
Kodak DCS620X Kodak DCS660C
Kodak DCS660M Kodak DCS720X
Kodak DCS760C Kodak DCS760M
Kodak EOSDCS1 Kodak EOSDCS3B
Kodak NC2000F Kodak ProBack
Kodak PB645C Kodak PB645H
Kodak PB645M Kodak DCS Pro 14n
Kodak DCS Pro 14nx Kodak DCS Pro SLR/c
Kodak DCS Pro SLR/n

Wwww.Ccanto.com
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Nikon D1 Nikon D1H
Nikon D1X Nikon D100
Nikon D2H Nikon D70
Nikon E5000 Nikon E5700
Nikon E8700

Olympus C5050Z Olympus C5060WZ
Olympus C8080WZ Olympus E-1
Olympus E-10 Olympus E-20
Sigma SD9 Sigma SD10
Sinarback 22 Sinarback 44
Sinarback 23 Sinarback 54
Sinarback 43 Sinarback 54M

Sony DSC-F828

Check Canto’s website from time to time to see if any new cameras
are supported.

Canon Raw Metadata Support

Most cameras supporting Canon CRW files create additional
thumbnail files (THM files). The Canon Raw Metadata Support
enables Cumulus to capture metadata from these files and to
manage these files.

IPTC Information Window

This Cumulus Information window is specially designed for dis-
playing and editing the IPTC data of assets.

Requirements

This Cumulus 6 Option is an add-on module that expands the
functionality of a Cumulus 6.0.3 (or later) edition. It is already
included in the Cumulus Client, Cumulus Server or Cumulus Single
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User Edition software as a demo version. This means that it does
not need to be installed separately.

In order to get a full version, you just have to enter the correspond-
ing license information into the License dialog. (Add the serial
number first, then register with Canto and after that replace your
existing license information with the new one you have received.
This will activate your Cumulus system including this new Option.)
For details on adding Options, see the documentation for your
Cumulus Edition.

This Guide

This guide covers everything you need to know about working
with Cumulus Photo Suite in the following chapters:

+ Managing Raw Images - Covers the basics of working with
assets of raw image formats in Cumulus. (See “"Managing Raw
Images” chapter, starting on page 13.)

+ Using the IPTC Information Window — Describes how to use
the IPTC Information window. (See “Using the IPTC
Information Window” chapter, starting on page 21.)

Assumptions

Since the scope of this guide is limited to Cumulus Photo Suite,
some assumptions have been made about your knowledge. To
get the most out of this guide, you need to have a solid under-
standing of how Cumulus works. If you have a clear idea of what
catalogs, assets and records are and how they relate to each other,
then keep reading. If you don't fit this description, you may first
want to review the user guide for your Cumulus edition. The
“Learn” chapter contains a tutorial that guides you step-by-step
through Cumulus basics, and the “Explore” chapter provides in-
depth discussions of Cumulus functions and features.

Cross-Platform Issues

This manual offers explanations for all platforms supported by
Photo Suite. Though most of the program’s features are identical
in each version, portions of the user interface differ due to operat-
ing system conventions. These differences are explained when
necessary and assumed otherwise (e.g., the difference between

Wwww.Ccanto.com
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“maximizing” a window in Windows, and “zooming” a window in
the Mac OS is not explained).

Because there are so few differences between the Windows and
Mac OS user interfaces of Cumulus, the illustrations in this guide
apply to both platforms except where indicated.

@ This icon denotes what pertains to Mac OS X only.
H This icon denotes what pertains to Windows only.

User Interface Item Conventions

To differentiate user interface items—~buttons, menus, text fields,
etc.—from surrounding text, those items are displayed in bold. For
example:

“Click the Open button.”

To differentiate menu hierarchies, the » character is used. For
example:

“Select File » Open to open afile.”
This example means selecting the Open item from the File menu.

Cumulus Step by Step
Instructional steps are identified by the following structure:
1. This would be the first instruction. The mouse icon makes
it easy to identify.

2. Thefinalinstruction has a border beneath it, indicating that
there are no further steps.

Finding Help
If you have a question that is not answered in this guide, there are a
number of additional resources to check:

Canto Online

The Canto website (www.canto.com) contains many resources of
value to you as a Cumulus user. Among them Canto's User 2 User



Support Forums. These forums are non-moderated bulletin
boards hosted on the Canto website. Canto support does not
answer questions here, the forums are user to user only. Feel free
to use the forums to discuss any problems you may be having
using the Cumulus and receive help from other Cumulus users.

Technical Support

To provide you with easily accessible, first-class assistance, Canto
has partnerships with numerous distributors and resellers around
the world. Technical support from your distributor via e-mail is free
of charge for registered Cumulus users. For information on how to
contact the distributor or reseller in your area, inquire where you
purchased Cumulus or see Canto's Website (www.canto.com).
Before submitting your question, please review the support form
in the documentation folder on your Cumulus CD-ROM to make
sure that you provide the technical support team with the appro-
priate information.

If you are a registered Cumulus user and your distributor does not
provide support for Cumulus, you may address questions to:

The Americas -> support@canto.com
Rest of World -> support@canto.de

Additionally, you have the option of purchasing a Canto Service
Agreement, which not only includes priority technical support by
telephone, but also supplemental benefits, such as access to new
filters and a monthly bulletin full of helpful tips, technical news and
further information on Canto products. Please visit Canto's Website
to find out how to register for a Service Agreement and receive
extra support.

Wwww.Ccanto.com
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With Photo Suite, users can manage raw format images effi-
ciently. This chapter describes the basics of working with raw for-

mat images.

Managing Raw Images



14

CUMULUS® PHOTO SUITE - USER GUIDE

Cataloging Raw Image Formats

When cataloging raw image formats your catalogs and Asset Han-
dling Sets have to prepared for this. The catalogs in which you
want to manage your raw images must provide the correspond-
ing record fields to store the special raw image information and
the Asset Handling Sets you want to employ must have the Digital
Camera Raw Filter activated. Its format entries must be in a certain
sequence to gain best results. See "Employing the Digital Camera
Raw Filter,” p. 16, for a description of the sequence that is best.

Captured Information

When cataloging, the Digital Camera Raw Filter can capture the
following information from your raw images:

rInformation

Digital Camera Raw Filter: Aftitude, Aperture, Aperture (String),
Authar, Camera 1D, Camera Manufacturer, Camera Model, Captured
Date, Color Mode, Color Space, Cortrast, Custom Rendered, Date
Time Digitized, Date Time Criginal, Digital Zoom Ratio, EXIF Yersion,
Expozure Bias, Exposure Mode, Exposure Program, Exposure Time,
Expozure Time (String), File Formmat, Flash Mode, FlashPix Yersion, F
Murnber, F Mumber (String), Focal Length [mm], Focal Length 35mm
Filtm [min], Gain Control, Horizontal Resaolution, ICC Profile Mame,
Image Height, Image Orientation, nage Source, Image YWidth, ISO
Speed, Latitude, Lens Info, Light Source, Longitude, Max Aperture,
Maix Aperture (String), Meter Mode, Saturation, Scene Capture Type,
Scene Type, Sensing Method, Serial Mumber, Sharpness, Shutter
Time [s], Software, Sound File, Subject Distance, Subject Distance
Range, Thumbhail, User Comment, Yertical Resaolution, White Balance
Mode

Of course the filter can only capture the information contained in
the cataloged images. The captured information will be stored in
Cumulus record fields.

Some of the fields above may not be active in the catalog to which
you want to add the raw images. To include them in a catalog, you
have to add the corresponding field to the Record Fields in the
Catalog Properties dialog before cataloging your documents or
updating your records. (For information on how to do this, see
“Adding Digital Camera Raw Filter Record Fields”, below.)

NOTE: Workgroup or Enterprise Edition!
Only the Cumulus Administrator or a user who has special rights is
allowed to change the properties of a catalog and add record fields.



Adding Digital Camera Raw Filter Record Fields

If you want the information stored for the cataloged raw image to
include the information that can be captured by the Digital Cam-
era Raw Filter, you have to add the corresponding record fields to
the catalog.

To add the special records fields of the Digital Camera Raw Filter to
your catalog:

1. Make sure the collection window containing the catalog is
the active window in Cumulus.

2. Select ® Cumulus/ /) Edit » Preferences.
3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active
collection window contains more than one catalog,
select the catalog you want to edit under Catalogs.

4. Click Record Fields. This displays a list of the current record
fields included in the catalog.

5. Click the Add Field button. This opens the dialog Add
Field.

6. Click the Modules tab.

The Modules tab displays a list of all Cumulus modules
that provide fields. If you click on the plus sign in front of
a module’s entry, the list expands and displays the fields
supported by this selected module and that are not
included in the catalog yet. You can either select a mod-
ule’s entry itself and all fields supported by the module
will be added. Or you can expand the list and select a cer-
tain field to be added.

7. Select the Digital Camera Raw Filter.

8. Then as explained above: If you want to add all fields the
Digital Camera Raw Filter provides, select the entry for the
Digital Camera Raw Filter.

OR
If you want to add certain fields only, select the field(s) you
want to add.

Record
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TIP: You may even want to add EXIF fields to the catalog.
If yes, then do it now.

9. (Click OK.This brings you back to the fields list to which the
fields have been added.

10. Click Apply to save your changes.

To view the contents of these fields, they have to be added to a view
of a Record View Set. For information on how to do this, see the user
guide of your Cumulus Edition.

The Digital Camera Raw Filter

The Digital Camera Raw Filter enables Cumulus to capture infor-
mation when cataloging raw images and to preview raw images.

Employing the Digital Camera Raw Filter

The Digital Camera Raw Filter is the only Cumulus filter that can
read raw images. However, the entry numbers of the formats sup-
ported by this filter are important. When cataloging, Cumulus
starts searching for matching formats at the lowest entry number.
It employs the formats according to their entry numbers (lowest
entry number first). If you want the Digital Camera Raw Filter to be
employed for assets, check the order of the format entries.

In order to ensure the Digital Camera Raw Filter works ideally for
cataloging assets, you have to move the entries for the formats
supported by it up in the list, such that they are at least before the
first format supported by the TIFF Filter. The Sinar DC Raw Image
Format should have a lower entry number than the first format
supported by the Photoshop Filter.

Defining Filter Properties

The Digital Camera Raw Filter allows you to define properties for
the different formats supported by this filter.

+ Canon DC Raw Image (extension: crw, Mac File Type: CCDR)

+ Fuji DC Raw Image (extension: raf, Mac File Type: RAF *)

+ Kodak DC Raw Image (extension: dcr, Mac File Type: KDCR)

+ Minolta DC Raw Image (extension: mrw, Mac File Type: MRW *)
+ Nikon DC Raw Image (extension: nef, Mac File Type: NEF *)
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+ Olympus DC Raw Image (extension: orf, Mac File Type: ORF *)
+ Sigma DC Raw Image (extension: x3f, Mac File Type: FOVb)
+ Sinar DC Raw Image (extension: sti, Mac File Type: TIFF)
+ Sony DC Raw Image (extension: srf, Mac File Type: SRF *)
* Mac File Types with 3 characters only end with a space

These properties are important for cataloging and previewing. For
cataloging they are important only if you have activated the
option Entire Asset under Create Thumbnail from on the Thumb-
nail tab of the Asset Handling Set employed for cataloging. Then
the values set for the color settings and the color interpolation are
used for creating the thumbnail.

For the previewing of each of the formats, you can define the
source for a preview (thumbnail or entire image). If the source for
the thumbnail to be created or the preview to be shown is the
entire asset, the color settings and the color interpolation can be
set.

To define these properties:

1. Select @ Cumulus/ [f Edit » Preferences.
2. Click Asset Handling Sets.
3. Under Set, select the set you want to edit.

4. Click Asset Formats. The list of formats supported by the
installed filters is displayed.

Wwww.Ccanto.com
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7.

To define the properties of a format, select the entry for

this format.

Click on Properties. The Properties dialog for this format

opens.

Kodak DC Raw Image

Make your selections.
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+ Image Source for Preview
Decide which source is to be used when an asset of the
selected format is previewed
— Use Thumbnail Stored in Raw Image File
Fast but may be of lower quality
— Use Raw Image
More time consuming but often of better quality (e.g.
high resolution)

+ Color Setting
These settings are used only when the raw image is used
as source for previewing or when the thumbnail is cre-
ated from the entire asset while cataloging.
— Gamma Value, Brightness, Red Scale, Blue Scale
Enter the values you want to use with the selected for-
mat.
— Use Camera White Balance (if available)
If Camera White Balance is available with the image, acti-
vating this option delivers the quality in which the image
was taken.
— Use Four Color RGB
Activating this option may increase the quality of the pre-
view or thumbnail for certain images

+ Color Interpolation
These settings are used only when the raw image is used
as source for previewing or when the thumbnail is cre-
ated from the entire asset while cataloging. Select the
method of color interpolation (Bayer interpolation) for
images of the selected format:
— Bilinear
Standard method
— Variable Number of Gradients (VGN)
More time consuming but better quality

8. (lick OK to save your settings. The Properties dialog is closed.

9. Click Apply to save your changes.

Canon DC Raw Image & Thumbnail File

Most cameras supporting Canon CRW files create additional
thumbnail files. Along with a 160 x 120 JPEG thumbnail of the orig-
inal image in the associated CRW file, these files contain the EXIF

Wwww.Ccanto.com
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information and optionally IPTC information. They always have the
same name as the original CRW file, but with a THM file extension.

Photo Suite supports these THM files. If the Canon Raw Metadata
Support is activated in the Asset Handling Set employed for the
CRW image, the THM files are treated as follows:

- Ifanimage of this format is cataloged, the associated THM file

will not be cataloged but the information it contains will be
captured by Cumulus and stored in the record for the image.
NOTE: If the Canon Raw Metadata Support is activated when
cataloging, you get a list displayed that informs you of the
THM files have not been cataloged.

+ If you employ Cumulus to manage the cataloged image

(copy, move, e-mail or delete), the associated THM file will be
processed as well. Only when you employ the special copy
function to select a category and then copying the associated
assets by dragging this category on your desktop, the THM
files will not be copied as well.

+ If you rename the assets employing the Cumulus Rename To

function, the THM files will not be renamed as well.

The Canon Raw Metadata Support is activated by default. If you
want to deactivate it for certain Asset Handling Sets, see your
Cumulus Edition's user guide for a description on how to do this.



The IPTC Information window lets you easily view and edit IPTC
metadata. This chapter covers the basics of working with IPTC

metadata and the IPTC Information window.

Using the IPTC
Information Window
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Preparation Steps

In order to make use of Cumulus IPTC data management capabili-
ties, some preparations have to be made. The Cumulus catalogsin
which you want to store IPTC data from assets have to be pre-
pared. If you want to capture IPTC data from assets and to write
back IPTC data to assets, the Asset Handling Set(s) and the cata-
log(s) managing these assets must be prepared for this feature.
IPTC record fields have to be added to the catalog(s) and their
properties have to be enabled for field linking. The Writing Meta-
data to Asset option must be activated in the Asset Handling Sets
used to handle the assets containing IPTC data.

Cumulus provides a script to help make the process of preparation
easy: Prepare Catalog For IPTC (found in the Special menu; see
your Cumulus edition’s user guide for details). As image files often
contain IPTC and XMP metadata, we recommend preparing the
catalog for XMP as well (found in the Special menu). In order to
know what you should be aware of when working with IPTC and
XMP metadata, see the note that follows the description on how
to prepare catalogs for metadata in your Cumulus edition’s user
guide.

NOTE: Workgroup or Enterprise Edition!
Only the Cumulus Administrator or a user who has special rights is
allowed to change the properties of a catalog and add record fields.

IPTC Information Window

This Information window is specially designed for displaying and
editing the IPTC data of assets. Cumulus can read IPTC metadata
information while cataloging. You can view and edit this metadata
and Cumulus can write your changes back to the asset. Cumulus'
management of IPTC information conforms with the IPTC standard.
Being considered the industry standard its specifications are avail-
able to the public. Adobe Photoshop also uses this standard par-
tially, meaning that text in images captioned in Photoshop's File
Info will be displayed in the IPTC Information window. Photoshop
only uses some of the available fields the IPTC standard comprises
of. Note that even if the other fields are not displayed in Photoshop,
they are interchangeable between Cumulus and Photoshop.

NOTE: Writing IPTC Data back to Assets
If you want to write back IPTC data to assets, your Cataloging
Options (entry for the IPTC filter activated) and the catalog manag-



IPTC INFORMATION WINDOW

ing these assets must be prepared for this feature. IPTC record
fields have to be added and their properties have to be enabled for
field linking. Also the Writing Metadata to Asset option of the
Asset Handling Set employed for asset access must be set to
Silently or Always. Cumulus provides a script to help make the
preparation process easy: Prepare Catalog For IPTC (found in the
Special menu; see your Cumulus Edition’s user guide for details).
The IPTC data will be written back to the asset when any record
information has been changed.

To open the IPTC Information window:
1. Click once on arecord to select it.

2. Select Asset » IPTC Information. The IPTC Information
window for the selected asset’s record opens.

If you have selected more than one record before selecting
IPTC Information, the IPTC Information window will be
opened for the selected records and will display only val-
ues only that the selected records have in common. To see
or edit the IPTC data of one record only, use the arrow but-
tons.

Once the IPTC Information window is opened, you can use the
arrow buttons to load other records of the current collection into
the window.

Information can be added by entering text into the field or select-
ing from lists — so called 'quicklists'. Some fields provide prepared
lists for immediate use. For some fields these quicklists are preset
and contain values laid down by the IPTC norm. Due to IPTC stan-
dards, the preset quicklists for some of the fields can't be edited.
The quicklists for all other fields can be edited.

To open or edit a quicklist for a field, make a right /alternate mouse
click in the field. This opens a drop-down list for selecting a value.
The fields for which you can edit the corresponding quicklist pro-
vide an entry Edit Quicklist. If you select this entry, a dialog for edit-
ing the quicklist opens. See "Editing Quicklists,” below, for details.

See the following overview of the options available from the IPTC
Information window.

Wwww.Ccanto.com
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Overview: The IPTC Information Window
The IPTC Information window provides access to the IPTC data stored on an asset.

To open the IPTC Information window: Select a record first and then select Asset » IPTC Information
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entries will be added to the existing entries).

NOTE: If a quicklist contains more than ten values for one field, the display of
the value is split into submenus.

The fields for which you can edit the corresponding quicklist provide an entry
Edit Quicklist. If you select this entry, a dialog for editing the quicklist opens.
(See “Editing Quicklists,” p. 26 for details.) If a field contains a value that is not
included in the quicklist yet, an entry Add to Quicklist is provided. Use this
entry to add the current entry of the field to the quicklist.

Saves the changes.

Loads the first record from the collection window’s current selection.

Loads the previous record from the collection window’s current selection.
Loads the next record from the collection window’s current selection.

Loads the last record from the collection window’s current selection.

Opens a dialog for importing a quicklist. (See “Exporting and Importing
Quicklists,” p. 26 for details.)

. Opens a dialog for exporting a quicklist. (See “Exporting and Importing

Quicklists,” p. 26 for details.)
Saves the changes and closes the windows.

. Closes the IPTC Information window without saving changes.

Saves the changes without closing the window.

The letters mark a few examples of the various field types.

A

Most of the fields in the IPTC Information window are text fields. They allow
you to enter text of one or more words. You can enter characters, numbers
and special characters. The Caption and Special Instructions fields allow you
to enter several lines of text.

Keywords and Supplemental Categories: These fields allow you to enter a
number of entries consisting of one or more words. You enter a keyword by
typing the word and then pressing the Enter key or clicking the Add button.
You can then start typing the next entry immediately.

IPTC Category and Country Code: These fields can only contain a 3-charac-
ter abbreviation. The corresponding quicklist lets you only add 3 characters.
These Date fields allow only values that are laid down by the IPTC norm. Due
to this, you can only choose one of the standardized values for them after per-
forming a right mouse click /alternate mouse click.

These Time fields can either be filled from the menu opened after performing
a right mouse click /alternate mouse click or by entering a time value. If you
enter a value for the time, use the format: hh:mm:sec

Urgency and Object Cycle: These are record fields of the type String List. You
can select avalue from the list opened after clicking the arrow button. To edit
the provided values, you have to edit the record field properties (for a descrip-
tion on how to do this, see the manual of your Cumulus Edition).
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Viewing and Editing Multiple Records

If you have selected multiple records before opening the IPTC
Information window, you can change the field values for multiple
records at once.

If the information of multiple records is shown in one window,
only field contents which have the same value are displayed.

IR

Caption | Categories & Keywards | Date & Status | Miscellanecus |

Caption

Multiple values...

Special Instructions

Multiple values...
Object Natne

Headlling

| Mt values. .
Byl
[smitn

Use right click! CTRL-chick on fields for Quicklists

Ok I Cancel | Apply |

Fields with multiple values do not show a value, but can be edited.
When you edit them, the handling is different for different fields:

+ Keyword, Supplemental Category, Urgency, Object Cycle,
as well as all Date and Time fields: The new value will replace
the existing values.

« All other fields: You are asked whether you want the new
value to replace the existing value or to be appended to the
existing value.

Wwww.Ccanto.com
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Editing Quicklists

The list displays the current values for the corresponding field. You
can edit or delete these values or add new values to the list.

Eﬂulckllst Editor x|

IEathﬂn Daap‘

Replacs

Delete

Johin Smith

Cancel

To add a new value:

Enter the new value in the field above the list and hit the Enter key
or click the Add button. You can then start typing the next entry
immediately.

To edit a value:

Select the value. The value will be displayed in the field above the
list. Edit the value in this field and then click Replace. The value in
the field will replace the selected value in the list.

To delete a value:
Select the value in the list and click Delete.

Exporting and Importing Quicklists

Once you have adapted a quicklist to suit your needs, you may
want to save it for special purposes or provide it to other users.
That's why Cumulus offers you the option of exporting and
importing quicklists. When exporting a quicklist, it is saved into a
document of the type QLS File (file extension: gls). To make use of
such an exported quicklist with the IPTC window, you have to
import this list by opening the document it is saved to.

To export a quicklist (saving it to a document):

i
1. Selectthe g button in the IPTC Information window.



A dialog for selecting a location opens.

E Save
Savein I@ My Documerts: LI EF
File name: || Save |
Files of type: IQuigk"stS LI Cancel |

2. Enteraname, select a location and click Save

Now the list is saved and can be imported.
To import a quicklist:

o

1. Select the button in the IPTC Information window.

2. Adialog box to choose the list opens.
El:lpen

Look in; I@ My Documents

Fl BcE=E

File name: I

Opeh

Fies of type:  [vickicts

ﬂ Cancel

3. Select the desired list and click Open.

Your quicklist will then be available in the IPTC Information window.

IPTC INFORMATION WINDOW
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